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1. Introduction to Kernel for Access 

Welcome to the user manual for Kernel for Access, the most effective and convenient .MDB database 
recovery tool that rebuilds and repairs corrupt Access databases. This user manual comprises step by step 
guidelines on using Kernel for Access. 

1.1 Using this Manual 

This user manual is intended to guide users on using Kernel for Access. We suggest that first time users 
should read this user manual completely and carefully before proceeding to use the software. However, if 
you are an experienced user, you can use the table of contents to find out information pertaining to the 
tasks that you need to perform by using Kernel for Access. You can use the table of contents to navigate 
through different sections of this user manual. The table of contents lists all the sections that are contained 
in this user manual in chronological order. The user manual comprises the following sections: 

 Introduction 

 Getting Started 

 Software Interface 

 Repairing Corrupt Access Database Files 

 Saving Repaired Access Files 

 Full Version 

 Support 

 Troubleshooting 

 Legal Notices 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

MS: Microsoft 

RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 

MDB: Microsoft Database 
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1.2 About Kernel for Access 

Kernel for Access – Database Repair Software repairs corrupted .MDB database files which get corrupted 
due to unexpected system shutdown, virus attacks or error reading media. Kernel for Access performs 
intensive scan of the corrupted file to determine the intensity of damage and Kernel Access fixes those 
corruption. 

Kernel for Access, repairs the damaged databases due to following errors: 

 System shutdown unexpectedly 

 Virus corruptions 

 Media corruptions 

 "Unrecognized Database Format" 

 "The database  needs to be repaired or isn't a database file" 

 “The Microsoft Jet database engine could not find the object” 

1.3 Salient Features 

Salient features of Kernel for Access include: 

 Recovers table structure and data 

 Restores key data structures like auto number, primary key, field size and many more 

 Converts MDE database file to MDB database file 

 Restores Memo data 

 Restores OLE data 

 Restores Table Relationships 

 Restores Original Date Format 

 Uses Live Preview technology, to retrieve the database structure from the corrupt database and 
displays the Live database preview 

 Recovers password protected Access databases (Even if the password is NOT KNOWN to the user) 

 User friendly interface, no technical skills required 
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1.4 Who Should Use this Software? 

The capability of Kernel for Access to repair large sized Access databases makes it appropriate for use by 
organizations, individuals and professionals, who are worried due to corruption of their important Access 
database. This corruption could have been caused due to virus attacks, media corruption, unexpected 
system shut down or any other operational error. 
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2. Getting Started 

Now that you have understood the features and potential of Kernel for Access, you are ready to get hands 
on experience of the software. To start recovery from corrupt Access database, you will first need to 
download and install this software. 

It is strongly recommended that before installing Kernel for Access, you should go through the installation 
pre-requisites for the software to ensure that your computer is appropriately configured to run the 
software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for Access can be broadly classified into two 
major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor 

 Minimum 64MB RAM (128 MB recommended) 

 10MB for Software installation 

 Disk Space - Enough space to store the repaired files 

 You should have at-least 40 MB of free disk space if you want to repair and save a 
40 MB lost data. 

2.1.2 Software Requirements: 

The software requirements for installing the software can further be grouped into two categories – 
Operating system requirements and MS Access version requirements. The requirements are as follows: 

2.1.2.1 Operating System Requirements 

Supported operating systems: 

 Windows Vista 

 Windows XP 

 Windows 2003 

 Windows 2000 

 Windows Me 
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 Windows NT 

 Windows 98 

 Windows 95 

2.1.2.2 MS Access Version Requirements 

Supported MS Access versions: 

 MS Access 2003 

 MS Access XP 

 MS Access 2002 

 MS Access 2000 

 MS Access 98 

 MS Access 97 

 MS Access 95 databases 

2.2 Downloading Kernel for Access for the First Time 

After checking your computer with the prescribed system requirements for Kernel for Access, you can 
download and install the software on your computer. You can buy the full version of the software from any 
one of our authorized resellers – Element5, Asknet and 2CO. 

If you want to try using Kernel for Access before buying it, you can download the evaluation version from 
the following link: 

http://www.nucleustechnologies.com/Download-Access-Databases-Repair-Software.php  

 You can repair .MDB files saved on your system by using the evaluation version of 
Kernel for Access; however, the repaired file will not be saved until you purchase the 
full version of the software. 

2.3 Install Kernel for Access 

After downloading the installer file for Kernel for Access, you can install the software by running the file. To 
install Kernel for Access: 

1. Double-click the Kernel for Access installer. 

2. Follow the on-screen instructions. 

The Setup Installation Complete screen will be displayed. 

http://www.nucleustechnologies.com/Download-Access-Databases-Repair-Software.php
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3. Click Finish to launch the software. 

2.4 Start Kernel for Access 

To start Kernel for Access: 

Click the Start  All Programs Kernel for Access 

Alternatively, you can launch Kernel for Access by double-clicking the shortcut icon available on the 
desktop and Quick Launch icon. 

2.5 Uninstall Kernel for Access 

You may need to uninstall and re-install Kernel for Access. To uninstall Kernel for Access: 

1. Click the Start  All Programs Kernel for Access  Uninstall Kernel for Access 

A warning message will be displayed. 

2. Click „Yes‟ to uninstall Kernel for Access. 

 Before proceeding to uninstall Kernel for Access, you must ensure that the software 
is not running. 

You can alternatively uninstall Kernel for Access from the Control Panel by performing the following 
steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon. 

2.  Select Kernel for Access and click Remove. 

A warning message will be displayed. 

3. Click „Yes‟ to uninstall Kernel for Access. 
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3. Software Interface 

Now that Kernel for Access has been installed on your computer, you can start using the software after 
getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for Access comprises three main menus – File, Tool and Help. 

3.1.1 File Menu 

The File menu comprises three menu items. 

 

Figure 3.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Add Adds corrupt Access files for repairing 

Save Saves all repaired files 

Exit Closes Kernel for Access 

3.1.2 Tool Menu 

The Tool menu comprises one menu item. 

 

Figure 3.2: Tool Menu 

Menu items in the Tool menu: 

Field Name Field Description 

Live Update Updates the current software with the available 
version in the Nucleus server 
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3.1.3 Help Menu 

The Help menu comprises three menu items. 

 

Figure 3.3: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Help Displays help information pertaining to performing various 
tasks using Kernel for Access 

Software Homepage To visit the software homepage on our website 

About Nucleus Kernel 
Access 

View version-related and support information of Kernel for 
Access 

3.2 Tool-bar 

The tool-bar in Kernel for Access is displayed below the menu-bar. The tool-bar provides a convenient and 
user-friendly method to perform certain actions that can also be performed by using the menu-bar. Read 
the information in the table below to find out about the tool-bar buttons: 

Button Button Name Button Description 

 

Add File Adds corrupt Access files 

 

Repair File Repairs added files 

 

Save File Saves the repaired files 
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Live Update Updates the current software with the available 
version in the nucleus server 

 

Buy Online Opens the online buy page of software 

3.3 Status Bar 

Status bar is displayed at the bottom of the software window. The text „Ready‟ is displayed on the status 
bar if Kernel for Access is ready to be used. Status bar also displays the text „CAP‟, „NUM‟, „SCRL‟ which 
respectively correspond to the Caps Lock, Num Lock, and Scroll Lock keys on your keyboard. If any of 
these keys are pressed, the color of the corresponding text will turn blue/black. 

 

Figure 3.4: Status Bar 
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4. Repairing Corrupt Access Database Files 

Now that you have complete familiarity of the user interface of Kernel for Access, you are ready to repair 
.mdb files. 

To repair .MDB files: 

1. Launch Kernel for Access. 

2. Two modes of repairing are provided: Standard Mode and Template Mode. Choose accordingly. 

 Choose „Template Mode‟ when you have backup of the corrupted MS Access files 
otherwise use „Standard Mode‟. 

 

Figure 4.1: Select File  

3. Click Add Files option to add corrupted Access files for repairing. 
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4. Click Open to select the file for repairing or click Cancel if you don't want to repair that file. A new 
dialogue box will appear with the complete path of the selected files. Click Repair button on the bottom 
of the dialogue box or click Repair file from tool bar. 

5. Now Kernel for Access starts repairing the selected file and a dialogue box showing the status of 
repairing process appears. 

 

Figure 4.2: Repair Process Status  

6. Once repairing process is complete. Kernel for Access will display all the recovered tables and their data. 
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Figure 4.3: View Recovered Files  
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5. Saving Repaired Access Files 

All repaired access files can be easily saved with Kernel for Access. To save repaired files, you need to 
follow these simple steps: 

1. Click Save Button from the tool bar and choose the location where you want to save your file. 

2. Click Save and a new dialogue box showing the saving status will appear. 

3. Once saving process is complete the saving location of the files will get displayed at the screen of 
Kernel for Access. By clicking that location you can view the saved file. 
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6. Full Version 

Although you can use Kernel for Access evaluation version for free and experience the capabilities of the 
software, there are certain features that are not available in the evaluation version. 

6.1 Requirement of Full Version 

By using the evaluation version of Kernel for Access, you can view the preview of the database and can 
get idea about how many tables and records can be recovered from the database. This way you can verify 
with the demo version if it will repair your corrupt access database. 

You will need to buy the full version of the software to perform complete repairing process. 

6.2 Purchasing Full Version 

You can buy the full version of Kernel for Access from any one of our authorized resellers – Element5, 
Asknet and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email 
comprising the URL to download the full version of Kernel for Access and activation details of the 
software. 
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7. Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for Access. The software comes with an embedded help manual that can be accessed by 
clicking HelpSoftware Help in the menu-bar. You can also press the F1 key on the keyboard of your 
computer to access the embedded help of Kernel for Access. 

You can access the online help for Kernel for Access at http://www.nucleustechnologies.com/Online-
Helps.html 

View Animated Working Demo of the software at 

http://www.nucleustechnologies.com/accessdatabaserepair/animatedmdb.html 

We also have live support wherein you can chat with our software experts at 
http://www.nucleustechnologies.com/Support.html . 

To talk on phone with our software experts call: 

Help line:  
 

+91-9818725861 

1-866-348-7872 (Toll Free for US/CANADA) 

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

  

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/accessdatabaserepair/animatedmdb.html
http://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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8. Troubleshooting 

This section deals with your generic and specific queries pertaining to using Kernel for Access. 

8.1 Common Issues 

Why does Kernel for Access have limitations in evaluation copy? 

The free evaluation version of Kernel for Access is intended to enable you to experience the capabilities of 
the software. You will need to buy the software save the recovered data. 

8.2 Frequently Asked Questions 

How to Buy Kernel for Access? 

You can buy Kernel for Access online at http://www.nucleustechnologies.com/Buy-Access-Databases-
Repair-Software.php  

I have lost my full version for Kernel for Access. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

  

http://www.nucleustechnologies.com/Buy-Access-Databases-Repair-Software.php
http://www.nucleustechnologies.com/Buy-Access-Databases-Repair-Software.php
mailto:sales@nucleustechnologies.com
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9. Legal Notices 

This section comprises the legal specification about Kernel for Access and the company NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED 

9.1 Copyright 

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and 
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights 
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior 
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is 
assumed, however, with respect to the use of the information contained herein. 

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved. 

9.2 Trademark 

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, MS-DOS and MS Office are 
registered trademarks of Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

9.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty 
with regard to this manual or any other information contained herein and here by expressly disclaims any 
implied warranties of merchantability or fitness for any particular purpose with regard to any of the 
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages 
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or 
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary 
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or 
any other information contained herein or the use there of. 

9.4 License Agreement 

Kernel for Access Copyright © by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM 
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of 
each Licensed Copy of Kernel for Access. For purposes of this License, if you have a valid license, you 
have the right to use a single Licensed Copy of Nucleus Kernel. 
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Scope of License 

Each Licensed Copy of Kernel for Access may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All 
rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are entirely and 
exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. You may not rent, 
lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on, 
Nucleus Kernel, nor permit anyone else to do so. You may not make access to Nucleus Kernel available 
to others in connection with a service bureau, application service provider, or similar business, nor permit 
anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for Access, and any and all accompanying software, files, data and materials, are distributed and 
provided AS IS and with no warranties of any kind, whether expressed or implied. In particular, there is no 
warranty for the quality of data recovered. You acknowledge that good data processing procedure dictates 
that any program, including Nucleus Kernel, must be thoroughly tested with non-critical data before there 
is any reliance on it, and you hereby assume the entire risk of all use of the copies of Nucleus Kernel 
covered by this License. This disclaimer of warranty constitutes an essential part of this License. In 
addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED authorize you or 
anyone else to use Kernel for Access in applications or systems where Kernel for Access failure to 
perform can reasonably be expected to result in a significant physical injury, or in loss of life. Any such use 
is entirely at your own risk, and you agree to hold NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 
harmless from any and all claims or losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein. 

 Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by 
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED of any other or future violation of the same provision, or any other provision, of this License. 


